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Completing the Employee Evaluation — Managers Job Aid

The employee, manager, and reviewing manager all have an active role in the evaluation process.

This document includes the steps that managers should follow to complete the employee’s
performance evaluation in ePerformance.

Step 1: Manager receives email notification that their employee has completed the
Employee Self Evaluation (if applicable) OR Manager is notified by HR that it is time for
them to complete the year-end evaluation. See example below.

[From: Employee Self Service Email [mailto:SAQ PS email@sao.ga.gov]
Sent: Friday, Movember 09, 2012 10:19 AM

To:
Subject: Your employee has completed their self evaluation
Y our emplovee has completed their self evaluation for Annual Performance Beview :

https:/'route88 . state ga us/'psp'sao/’cmd=login (Please do not respond to this automatic
notification )

Step 2: Log into the Route 88 URL https://route88.state.ga.us
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Logging in on this screen will take you directly to the Main Menu screen for PeopleSoft HCM.
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https://route88.state.ga.us/

Step 3: Click on Manag
ORACLE

Search:

- Sulf Serdce
[ Manager Seif Senice
) Wondorce Admi

I Warklorce Develcomant

I Set Up HRMS
[ Entedprise Companants

e
My Sestern Profile
My.Qictionare

[ c|oulw|;;m & Abzence Mgmt
- Drganizabonal Development

er Self Service

Personalize Content | Lavout

Manager Leave Summary
The na information iilable for
dsipliny ab thiss Brm

Employee Lave Summary

Leave Bolances

= T

ESTE |

Step 4: Click on Perfor

Menu B
®

'Search:

> My Favorites
- Self Service
=

I> Time Management
[ Job and Personal

Information

mance Management

o Manager Self Service

Navigate to self service information and activities for people reporting to you

Review Transactions Time Management
¥ Review that you , view and approve

reported and payable time, sbsence and
overtime requests, exceptions, and more:
[ Manage Schedules

> Performance Management
5L

L1 Aporove Time and Exceptions
1 Report Time

I> Succession Planning
— Review Transactions
[ Workforce Administration
(> Time and Labor
[ Global Payroll & Absence
gmt

2 Hore

Performance Management

Plan, evaluate and manage performance and
development for your workforce.

[ Performance Documents

= Mass Approvals

@F‘ Learning and Development

Add and review information related to learning
and development for empioyees.
=] Training and Development Home
] Training Summary

d

[ Workforce Development =] Request Training Enrollment = Aporove Documents
> D Tt 10 More. & More.

[ Set Up HRMS

[ Enterprise Components
- Worklist

[ Reporting Tools

[~ Change My Password
(~ My Personalizations

I~ My System Profile

(— My Dictionary

£ Succession Planning

| | Manage employee Succession Flans
=] Succession 360°

¥l Manage Succession Plans

ﬁ‘h

Sign out

Job and Personal Information

Manage job and personal information for your
employees.

=l View Employee Personal Info

ﬁ] Career Planning

Manage Career Planning Self Service
=l Manage Career Plans
=] Career Progression Chart

OVEE[HRMS(c/ROLE_MANAGER: HCM_APPR_STATUS.GELZPORTALPARAM P [ [ |

A A00% -
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Step 5: Click on Performance Documents

|  Addte Faveri | Ssign out

search:
> My Favorites
PIEn, evaluate and manage performance

(- Self Service
-@ rformance Documents = Mass Aporovals Approve Documents
I Time Manager Mass Approvals Approve or deny a performance document

I Job and Personal documents for your workforce. that is in your approval queue.
Information =] Create Documents
[ Learning and Ds =] Current Documents
I> Performance Management =] Historical Documents
1> Career Planning ] View-Only Documents
I Succession Planning
— Review Transactions
[ Workforce Administration
(> Time and Labor
[ Global Payroll & Absence
Mgmt
(- Workforce Development
[ Organizational Development
[ Set Up HRMS
[ Enterprise Components
- Worklist
[ Reporting Tools
[~ Change My Password
(~ My Personalizations
I~ My System Profile
(— My Dictionary

&pment for your workforce:

= View Approval Status = Approver Doc Status Report =l Approver Review Rating Report
View the approval status of documents that Approver Doc Status Report Approver Review Rating Report
you own.

= Manager Review Rating Report = Maintain Performance Notes =l Change Document Due Date
Manager Review Rating Report Enter notes regarding an employee's Change the due date of a performance
performance. document

Internet

tats fhrd 1 dev/EMPL 16_PTPP_SC.HOMEPAGE. FieldFormula. I5cript_fppHPzsc| [ | [ || # 100% -

Step 6: Click on Current Documents

Sign out

® ﬁ Performance Documents
- My Favarites

[ Self Service. Create, update, and view performance documents for g
[l anager Service E reate Documents Current Documents
> Time Management reate performance documents for your

Update or view your empioyees’
I Job and Personal direct reports. — —
Information

I> Learning and Development
[ Performance Management View-Only Documents
I Career Planning =l view performance documents for direct and
I Succession Planning indirect reports.
- Review Transactions

(- Workforce Administration

[ Time and Labor

(- Global Payroll & Absence
Mgmt

[ Workforce Development

[ Organizational Development

(- Set Up HRMS

[ Enterprise Components

(- Worklist

[- Reporting Tools

(~ Change My Password

I~ My Personalizations

(— My System Profile

[ My Dictionary

performance documents.

| T [ [ meemet

100% -
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Step 7: Click on the appropriate employee’s document you are ready to evaluate

»
. Mo Window | Help | Customae Pege | &
Current Performance Documents
Listed below are he curent performance documents for which you are the Manager.
Perfonmance Documents
-IW . .MW B i e
Aanud Padormiece Ry DTOI20MT  DBMAZONE "'"" ey Anabd 1h Prgrass 450148
24 Pectorm: DSOIZ01S  OTMORIIE :’&mm’m In Frogtess 460148
Anny Perfprmance Redaw 07002 | 0EA020M3 r'f}w'm In Progress 460148
s PitmanE Rndew  O7AVR009 06002010 S 1 prngress 60148
ooy Pedpmmance By 07012008 06002008 :’;:’“”‘“‘m In Prespress 0TI
snusPedomance Riew 06012016 0TROR0IT g;"“”‘“ Spedalist e 60837
Al Pedomance Bevow 07012013 08702014 g;““”"a“"’““nw es037
AnnusParomance Emiew 0701012 06R0E013 g;unmsumaun InProgiess s6063T
Ay Petomance Bndaw  07AM2016 06A00TT oo\ RES SPESEEL oy ey 50637
(Perymance Rodew 07012013 0600R014 fo 1o Res Soecialsl g g 460837
A Patomancs Bt 07OUZ012 06002013 For o ReS Specialst o 460837
fonBedomine Riey  OTOIROI0 DanoR01y £ M RES SOSCAE 1y oy 260637
Al »':'I
I T i

Note: All of the manager’s direct report documents should be listed. If any of your direct reports
are not listed, contact your agency’s HR Administrator.

If your agency incorporates the Employee Self Evaluation step, print out the employee self-
evaluation prior to moving to Step 8.

ORACLE’
Home | Workist | AddtoFavortes | Signout
Search- Mew Window | Help | Custamize Page | &,

@ Current Performance Documents

> My Favorites

b Self Senice Document Details
[~ Manager Self Service
[> Time Management , PS: Hum Res Specialist (WL)
[> Jab and Personal Annual Performance Review: 07/01/2029 - 06/30/2030
Information

[> Compensation and Stock Performance Document Details

> Learning and Development

Cd Job Title: PS: Hum Res Specialist (WL}
- D Type: Annual Review Period: 07/01/2029 -  0B/30/2030
te Dacuments . R .
Template: Annual Performance Review Document ID: 571434

~ Historical Documents Manager: Status: In Progress
— View-Only Documents Document Progress

— Mass Approval
— Approve Documents Step. Status Due Date: |action Next Action

— Wiew Approval Stalus
— Manager Review Rating Establish Evaluation Criteria + Completed 01/01/2030  View

Repont
- W Review Self Evaluation + Completed  07/31/2030

- Review Transactions
1> Agency Security

- Workforce Administration
- Benefits

1> Payroll for North America. Return to Select Documents
1> Workforce Development

> Organizational Development
1 SetUp HRIS

- Worklist

> Reporting Tools

1> PeapleTools

- Change My Password

|- My Personalizations

|- Ly System Profile

|- My Dictionary

Complete Manager Evaluation © InProgress  07/31/2030  Edit Submit

Done [ [ @ mtemet @&wu%vél

e Click on View next to Review Self Evaluation

DOAS Human Resources Administration —12/2012 5



Home | Workist | AddtoFavortes | Signout

New Window | Help | Customize Page | [&, ]
Performance Document - Annual Performance Review

> My Favorites N

1 Seff Service Self-Evaluation

[~ Manager Self Service
[> Time Management list (L)
> Job and Personal Annual Performance Review: 07/01/2029 - 06/30/2030

Information

> Compensation and Stock Author: Role: Employee
> Leaming and Development | Status: Completed Due Date:  07/31/2030
< Performance Management |  Approval:  Not Submitted

< Performance Documents

The document status is Completed

Current Documen
— Historical Documents e
— Vigw-Only Documents N

— Mass Approval

— Approve Documents

— View Approval Status

— Manager Review Rating

Return to Document Detail

Collapse All Expand Sections
ort
~ Maintain F = Section 1 - Core/lndividual Competencie
Notes
— Review Transactions Expand Collapse

[ Agency Security

- Bensfits
- Payroll for Narth America T =
- Workforce Development SSmwor: SxCL oD

- Organizational Development

- Set Up HRMS ¥ Results Orientation

- Worklist

[ Reporting Tools ¥ Accountability

- PeopleTools

I Fer=erarz=inre Judgement and Decision Making

- Wy System Profile

[~ My Dictionary L e e ——
Summary 50 %  (notless than 25%)
Weight:
Comments: | completed all steps in the section
[ [ [ [ [ [@untemet ST |
=

e Click the Expand All link

ORACLE’
Menu &

Search:
®

Add to Favortes | Sign out

Help | Customize Page | /B, ]

Performance Document - Annual Performance Review

> My Favorites

- Self Service Self-Evaluation
[ e PS:Hum Res Specialist (WL)
[> Jab and Personal Annual Performance Review: 07/01/2029 - 06/30/2030
Information ]
> Compensation and Stock Author: Role: Employee
> Learning and Development | Status: Completed DueDate:  07/31/2030
= Performance Management |  Approval:  Not Submitied

< Performance Documents
Create Documents

The document status is Completed.

Historical Documents

— View-Only Documents
— Mass Approval
— Approve Documents
— Wiew Approval Stalus

Return to Document Detail

— Manager Review Ratin: Expand All Collapse All Expand Sections
Repo
— Maintain Performance. < Section 1 - Core/Individual Competencies
Motes
- Review Transactions Expand Collapse

1> Agency Security

| Workiorce Administaton

- Benefits

1> Payroll for North America. Description

1> Workforce D [ that all have external and/or internal customers that they
> Organizational Development provide senices and information to; honors all of the State’s commitments to
- SetUp HRMS customers by providing helpful, courteous, accessible, responsive, and

- Worklist knowledgeable service

> Reporting Tools * Critical: Yes

> PeopleTools Rating: 3-Buccessiul Performer 3.00 B

- Change My Password

|- My Personalizations

| My System Profile Comments: | completed this process

|- My Dictionary

[ [@mtemet

| NS

All of the document sections will expand to show the ratings and comments entered by the
employee.

e Click on the View Printable Evaluation link (the printer icon)
The evaluation will appear in a PDF format. Once the document loads,

e Click on File (from the Tool Bar)
e Select Print from the File menu options

DOAS Human Resources Administration —12/2012



Step 8: Click on Start (or Edit) next to Complete Manager Evaluation

ORACLE
[ |
Search:

®

> My Favorites
1> Self Senvice
I+~ Manager Self Serice
> Time Management
> Job and Personal
Information
> Compensation and Stock
> Learning and Development
= Performance Management
< Performance Documents
— Creae Documents
— Historical Documents
— View-Only Documents
— Mass Approval
- Approve Documents
- View Approval Status
- Manager Review Raling

Repa
— Maintain Performance
Notes

— Review Transactions
[ Agency Security

[ Warkforce Administration
I Benefits

- Compensation

> Payroll for North America

Current Performance Documents

Home | Workist | AddtoFavortes |  Sianout

Mew Window | Help | Customize Page | o5,

Document Details

. $S: Clerk (EL)
Annual Performance Review: 07/01/2011 - 06/30/2012

%' You have successfully completed the Establish Criteria step.

Performance Document Details

Employee: Job Title:
Document Type: Annual Performance Review Period:
Template: Annual Performance Review Document ID:
Manager: Status:

Document Progress
step

Establish Evaluation Criteria + Completed 01/02/2012
Review Self Evaluation O ot Started 07/31/2012
Complete Manager Evaluation ' Not Started 07/31/2012

Status. Due Date \Action Hext Action

View

SS: Clerk (EL)
07/01/2011-  06/30/2012
537303

In Progress

‘ Start \

N P i

Return to Select D

1> Workforce D
1> Organizational Development
> Enterprise Learning

- Workforce Monitoring

> SetUp HRIS

- Worklist

> Reporting Tools

- PeopleTools

|- Change My Password

|- by Personalizations

|- by System Profile

|- My Dictionary

[ [ [ [@mtemet

H 0% -

If the manager has previously clicked on Start and only saved the information entered into the
evaluation, the Start option will no longer be available. You will now click on Edit to open the

evaluation.

Note: The Establish Evaluation Criteria step must have been completed before the Manager
Evaluation can be completed. If the Establish Evaluation Criteria step isn’t showing as
completed, the manager must first go into that step and “Complete” the criteria.

If the employee completed a self-evaluation, the status of the Review Self Evaluation (which
the employee completes on themselves) would read Completed or In Progress.

DOAS Human Resources Administration —12/2012



Step 9: Click on “Expand All”” link

Home | Workist | AddtoFavories |  Signout
Search: Mew Window | Help | Customize Page | 5, =
® Performance Document - Annual Performance Review
> My Favorites -
> Self Senvice Manager Evaluation
V”S"Tr'i‘f:'se"se"’“ _PS: Hum Res Specialist (WL)
[ Jab and Personal Annual Performance Review: 07/01/2029 - 06/30/2030 —
Information
I Compensation and Stock Author: Role: Manager
I Leaming and Development | Status: In Pragress DueDate:  07/21/2030
< Performance Management Approval: Mot Submitied
< Performance Documents
| Create Documents Enter ratings and comments for each section in this evaluation, if applicable. Save entries made on

ihe evaluation by Selecting the Save button
— Historical Documents

— View-Only Documents

— Mass Approval Save Submit for Approval & = Return to Document Detail

- Approve D
- View ApDioval Stalus | =

- Manager Review Ratin
Report Expand All ollapse All Expand Sections
— Maintain Performance

Notes - Core/Individual Competencies
— Review Transactions
I Agency Security Expand Collapse

> Workforce Administration

I Payroll for Morth America

> Workforce Development Description

b o D L that all have external and/or internal customers that they
I SetUp HRMS provide senvices and information to; honors all of the State’s commitments to

1> Worklist customers by providing helpful, courteous, accessible, responsive, and

- Reporting Tools knowledgeable service

- PeapleTools * Crifical: Yes

|- Chanae My Password Rating: - 0.00

|- My Personalizations

I~ My System Profile
|- My Dictionary Comments: @
) -
[ g oo -

Note: The Expand All link will open all sections of the document.

The Save button should be used continuously as you are entering information into the
system.

The Submit for Approval should only be used once you are completely finished
evaluating the employee and ready to submit the document to the Reviewing Manager
and HR for approval.

DOAS Human Resources Administration —12/2012



Step 10: Click on the drop down menu to select the appropriate rating for each item in
Section 1 (Core/Individual Competencies). Again, be sure to save often — the system will
time-out after a period of inactivity and you will lose any work that has not been saved.

ORACLE’
Home | workist | AddtoFavortes | Sinout
mens_ N N R .

(% | = Section 1 - Core/lndividual Competencies

I My Favorites Expand Collapse

I Self Service
proTEeTEne

> Time Management

1> Job and Personal Description
Information Understands that all employees have external and/ar internal customers that they .

1> Compensation and Stock provide senices and information to; hanors all of the State’s commitments to Rat| ng

[ Learning and Development customers by providing helpful, courteous, accessible, responsive, and —

“ sernvice. - -
< Performance Documents « Criical: Yes P Descr|pt|0n
ite Documents . nof =)<
T & :
orical Documents Icon

C

View-Only D
— Mass Approval

- Approve Documents L
ST Click inside the Comments

R box to enter comments
Report . I~

— Maintain Performance
Notes Spe” Check

— Review Tr

1> Agency Security P - )
- Workforce Administration i B Tempiate as/tezon2 75880 icon

I Benefits
I Payroll for North America ¥ Teamwork and Cooperation

I Workforce Development
c with others to common goals; warks with

employees within and across his/her depariment to achieve shared goals; treats

others with dignity and respect and maintains a friendly demeanor; values the

- Reporting Tools contributions of others.

- FeopleTools * Critical: Yes

- Change My Password Rating: = oo

|- My Personalizations

> Of D
> SetUp HRMS
I Worklist

|- My System Profile
|- My Dictionary Comments: €
) =
0 [ [@ tntemet A, |

Comments for each Competency should be entered inside the comment box for each individual
competency.

The ratings are based on a 5-point rating scale. Click on the Rating Description icon to
view description of the ratings: (see below)

ORACLE
Home | workist | Addto Favortes | Sinout

Search:
®

b My Favorites Customer Service

I Self Service

[~ Manager Self Senice "
> Time Management -

> Job and Personal " FL=is Description
Information Rt

I> Compensation and Stock e 1

b Learing and Development 1-Unsatisfactory Performer 1.00

= 2- Performer - 200

- D Lo}
— Create Documents Hinu
& 3Successful Performer 300
~ Historical Documents
~ Vigw-Only D 4 Performer -
- Mass Approval Plus
— Approve Documents
~ View Approval Status |z Eerformen 500
— Manager Review Rating
Report
— Maintain F
s Select Proficiency
~ Review Tr
[ Agency Security
I Workforce Administration Return to previous page
> Benefits
- Compensation
> Payroll for North America
I Workforce Development
> Organizational Development
1> Enterprise Learning
[ Workforce Monitoring
[ SetUp HRMS
I Worklist
> Reporting Tools
> PeapleTools
I~ Change My Password
|- Iy Personalizations

Mew Window | Help | Customize Page | [,

N

N

N-Not Rated 0.00

|- My System Profile
|- My Dictionary

Done [l [ [ [ @ mtemet ESCIR |
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Note: To spell check your comment, click on the Spell Check Comments icon.

Step 11: At the end of Section 1, click on the calculator icon to calculate the overall section
rating for section 1.

| Workist | AddtoFavorites |  Signout

: ®

> My Favorites

> Self Senvice

> Manager Self Service

> Time Management

[> Job and Personal
Information

[ Compensation and Stock

I Learning and Development

= Performance Management
= Performance Documents

— Create Documents

um
— View-Only Documents

— Mass Approval

~ Approve Documents

— View Approval Status

— Manager Review Rating
Report

— Maintain Performance

Created By: Tempiate 05/16/2012 T:554M

Description : Analyzes problems by evaluating available information and resources;
develops effective, viable solutions ta problems that can help drive the effectiveness of
the department and/or State of Georgia

* Critical: Yes

Rating: -l ooR

Comments: €

Motes

051812012 T:55AM

Crasted By: Template

~ Judgement and Decision Making

— Review T
- Agency Security

- Workforce Administration

- Benefits

1> Payroll for North America.

> Workforce Development

> Organizational Development
- SetUp HRS

1> Worklist

> Reporting Tools

1> PeapleTools

- Change My Password

|- My Personalizations

|- Ly System Profile

|- My Dictionary

Corefindividual Competencies Summary

Rating: 0.00 24 7]
Summary 25 5%  (notless than 25%)

Weight:
Comments:

= Section 2 - Individual Goals

=

[ [@mtemet

L 100% - A

ORACLE’
Menu &

Search:
®

I My Favorites

I Self Service

[~ Manager Self Service

> Time Management

1> Job and Personal
Information

1> Compensation and Stock

> Learning and Development

< Performance Management
< Performance Documents

Docum

~ Historical Documents
— View-Only Documents
— Mass Approval
— Approve Documents
— Wiew Approval Stalus
~ Manager Review Rating

— Maintain Performance
Motes
- Review Transactions
1> Agency Security
- Workforce Administration
- Benefits
1> Payroll for North America.
1> Workforce Development
> Organizational Development
1 SetUp HRIS
- Worklist
> Reporting Tools
1> PeapleTools
- Change My Password
|- My Personalizations
|- Ly System Profile
|- My Dictionary

| workist

051812012 T:55AM
081712012 8:27AM

Crested By: Templste
Last Modified By

Description - Analyzes problems by evaluating available information and resources;
develops effective, viable solutions to problems that can help drive the effectiveness of
the department and/or State of Georaia

* Critical: Yes

Rating: 2-Successful Performer -Mi=|  2.00 [

Comments: €

0571812012 T:554M
O5/1T/2012 8:2TAM

Greatea By: Tempiate
Last Modified By:

~ Judgement and Decision Making

Corefindividual Competencies Summary

Rating: 3-Buccessful Performer

Summary 50 % (notless than 25%)
Weight:
‘Comments: @

Enter section comments here

/Add to Favories

| Signout

=

Done [T T [ [ [@wemet

L 100% - A

The system will display the Summary Rating for Section 1. Additional comments on the
employee’s performance against the competencies can be added to the Section 1 Summary box.
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Step 12: Complete Step 10-11 for Sections 2 and 3 (based on sections identified by your
agency)

Note: If your agency is not using Sections 2 and/or 3 for those sections the rating should be N-
Not Rated and the weight should be 0%. (See screen print below)

~ Section 3 - Job Responsibilities

Add Job Responsibilities

Job Respon=* ues sSummary
Ratinf; N-Not Rated [

Summary
Weight:
Comments: @

Step 13: After all section ratings and comments have been entered, enter overall Manager
Comments for the review period.

ORACLE

Home | workist | AddtoFavortes | Signout

I My Favorites

I Self Service

[~ Manager Self Senice

> Time Management

1> Job and Personal
Information

I> Compensation and Sf

> Learning and Developy

< Performance Managem¥g
< Performance Document®

- Creae Documents
D

# Section § - Manager Comments

Comments:

al Documents
- ly Documents
— Mass Approval
— Approve Documents
— View Approval Status
~ Manager Review Rating Rating: 0.00 B
Report
— Maintain F @ &
Notes
- Review Transactions
I Agency Security
I Workforce Administration
> Benefits
[l Compensation
[ Payroll for North America
[ Warkfarce Develapment
> Organizational Development
> Enterprise Learning
- Workforce Monitoring
> Set Up HRMS
> Worklist
> Reporting Tools Add Individual Development Plan
I PeopleTools
|- Change My Password
|- My Personalizations
|- iy Svstem Profile

|- by Dictionary
Mo Attachments have been added to this document

Add Attachment

= Section 6 - Overall Summary

= Section 7 - Individual Development Plan

=
[ @ mtemet ST |
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Step 14: Enter Overall Summary comments for the review period

ORACLE

Home | Workist | AddtoFavortes |  Sianout

=

Search;

b by Favorites

b Self Senice

I Manager Self Senice
b Time Wanagement

> Job and Personal e €
Information

I> Compensation and Stock

I Learning and Development

< Performance Managsment
< Performance Documents

= Section & - Manager C:

- Creale Documents

|- current Documents |
al Documents
— View-Only Documents
~ Mass Approval
- Approve Documents
e = Section 6 - Overall Summary
ng: 0.00[
Report
— Maintain Perfor Comments: &
Notes
— Review Transactio
[ Agency Security
I Warkfarce Administratio
I Benefits
- Compensation
> Payroll for North America
- Workforce Development
I Organizational Development
1> Enterprise Learning

I- Workforce Monitoring
I Set Up HRMS

I Worklist

> Reporting Tools Add Individual Development Plan
I PeopleTools

|- Change My Password
|- My Personalizations
|- My System Profile

|- My Dictionary

= Section 7 - Individual Development Plan

Mo have been added to this document

Add Attachment hd
I o @mnemet '»‘;mn%v/ﬁl

Step 15: If applicable, enter Individual Development Plan comments

in Winedorars Inbermet | rphores

G_FH-[:! roe T o Y EVEEY B
B Ec s Fpoctes Toch e
@ vt + [ 5eet

| oo ey B ot s

ection 7 - Individual Development Plan

y

Cenacd Culdete
Docripiion (A |

impree presentaton shills by attendeg a teoday presentston sialn workahop and by
particpating n af kst four Toastmanter's sesison tes FY. INcorponate concepts Laght
= e thesughiut the year

Commants:

Note: This section is not weighted and will not be calculated with the employees overall
performance evaluation rating.
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Step 16: Click the Calculate All Ratings button at the bottom of the page

Worklist | Addto Favortes | Sian out

= Section 6 - Overall Summary

Search:
®

> My Favorites
1> Self Senvice
I+~ Manager Self Serice
> Time Management
> Job and Personal
Information
> Compensation and Stock
> Learning and Development
= Performance Management
< Performance Documents

— View-Only D

Rating: 000 B2
Comments: €

= Sectien 7 - Indivi Developi Plan

— l3ss Approval

— Approve Documents

- View Approval Status

— Manager Review Rating

Report
— Maintain Performance
Notes
— Review T

Add Individual Development Plan

MNo have been added to this document

[ Agency Security

I Workforce Administration
I Benefits

> Compensation

> Payrall for North America
> Workforce Development
> Organizational Development
1> Enterprise Learning

> Workforce Monitoring

1> Set Up HRMS

1> Worklist

> Reporting Tools

i PeapleTools

|- Change My Password

|- My Personalizations

|- by System Profile

|- My Dictionary

Add Aftachment

¥ Audit History
Created By: 05/02/2012 10:53:59AM
Last Modified By: 05i02/2012 10:59:59AM

Calculate All Ratings

Save Submit for Approval =

Return to Document Detail

I o @[nhemat

H100% - g

L=

Once you have clicked on the Calculate All Ratings icon, the employee’s overall performance

review rating will appear under Section 6 - Overall Summary (you may have to scroll back up

the page.

Worklst | Addto Favorites |  Sian out

: ®

1> My Favorites
> Self Senvice
> Manager Self Senvice
> Time Management
[> Job and Personal
Information
[ Compensation and Stock
I Learning and Development
= Performance Management
= Performance Documents

jstorical Documents
— View-Only Documents
— Mass Approval
— Approve Documents
— View Approval Status
- Manager Review Rating
Report
- Maintain Performance
Motes
- Reuiew Transactions
- Agency Security
1> Workforce Administration
- Benefits
> Compensation
1> Payroll for North America.
I> Workforce Development

= Section 6 - Overall Summary

Rating: 3-Successful Performer { 282F [ ‘

Comments: v @

< Section 7 - Individual Development Plan

l> Organizational Di
> Enterprise Leaming
1> Workforce Monitoring
1> SetUp HRIS

1> Worklist

- Reporting Tools

- PeapleTools

|- Change My Password
|- My P

Add Individual Dy Plan

Mo Attachments have been added to this document

Add

|- My System Profile
|- by Dictionary

¥ Audit History
Created By: 05/02/2012 10:59:59AM

Last Modified By: 05/02/2012 10:59:59AM

[ [ [ [@mtemet

*,100%

| SN [ENEE
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Step 17: Click the Save button

Home | Workist | AddtoFavortes |  Sianout
Search: ® = Section 6 - Overall Summary e
Rating: 3-Successful Performer 254

> My Favorites
1> Self Senvice T &
I+~ Manager Self Serice
> Time Management
> Job and Personal
Information
> Compensation and Stock
> Learning and Development
= Performance Management
< Performance Documents

— Create Documents
— Historical Documents
— View-Only D, = Section 7 - Individual Development Plan
— Mass Approval
~ Approve Documents Add Individual Development Plan
- View Approval Status
— Manager Review Ratin:

Repa
— Maintain Performance
Notes

~ Review T No have been added to this document
[ Agency Security
> Workforce Administration
> Benefits
> Compensation
1> Payroll for North America = Auit History
T Created By: 05102/2012 10:53:50AM
- Organizational Development
[ Enterprise Learning Last Modified By: 05/02/2012 10-59:59AM

Add Aftachment

I- Workforce Monitoring
I Set Up HRMS

I Worklist Calculate All Ratings

b Reporting Tools

> PecpleTools aluation —

|- Change My Password

|~ by Personslizafions Save Submit for Approval

|- Ly System Profile PP & = Returm to Document Detail
N

|- My Dictionary

| NI

[ [ [ [ [@mtemet #100% -
=

Once you have saved the performance document, you are still able to make additional edits to the
document. If you are sure you have completed the evaluation, go to Step 18. If you want to
close the document and return at a later time to submit for approval, then click on the
Return to Document Detail link.

Note: If you choose to only “Save” the document, you can click on the “Edit” button at a later
point in time to access the document in order to make additional edits.
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Step 18: Click the “Submit for Approval” button.

Home | workist | AddtoFavortes | Signout

Search: = Section 6 - Overall Summary B

o § =
b My Favorites Rating: 3-Successful Performer 254

> Self Senice Comments: &
[~ Manager Self Service
b Time Management
b Job and Personal
Information
> Compensatian and Stock
> Learning and Development
< Performance Management
 Performance Documents

~ Historical Documents
— View-Only O = Section 7 - Individual Development Plan
— Mass Approval
— Approve Documents £dd Individual Development Plan
— View Approval Status
~ Manager Review Rating
ort
~ Maintain Performance
Notes
~ Review T No have been added to this document
I Agency Security
I Workforce Administration
> Benefits
[l Compensation
[ Payroll for North America
[ Warkfarce Develapment 051022012 10:50:50AM
> Organizational Development
> Enterprise Learning Last Modified By: 0510212012 10:53:59AM
- Workforce Monitoring
> Set Up HRMS

I- Worklist Calculate All Ratings
1> Reporting Tools
> PeopleTools Cancel Evaluation,
|- Change My Password
|~ My Personalizations Save Submit for Approval & = Return to Document Detail
I~ My System Profile
O ——

|- by Dictionary

Add Attachment

| IR

Internet H100% -
[T T®

| Workist | AddtoFavorites |  Signout

Mew Window | Help | Customize Page | &,

Performance Document - Annual Performance Review

1> My Favorites

> Self Service Submit for Approval

= Manager Self Service
I> Time Management You have chosen to submit this performance evaluation for approval. To confirm that you would like
I> Job and Personal to submit the evaluation for approval, select the Submit button

Information

[ Compensation and Stock Do not submit this evaluation until you have completed each section. Once you select Submit, the
[ Learning and Development evaluation will be rotted through the approval process to the appropriate individuals. You will then
= Performance Management be notified through email on the approval status.

< Performance Documents

cal Documents
— View-Only Documents
— Mass Approval
— Approve Documents
— View Approval Status
— Manager Review Rating

The overall rating you have assigned to this document is 3-Successful Performer.

Cancel

Submit

Report
— Maintain Performance
Motes
— Review Transactions
[ Agency Security
[ Warkforce Administration
I Benefits
> Payroll for North America
- Workforce Development
I Organizational Development
> Set Up HRMS
> Worklist
I Reporting Tools
I PeopleTools
|- Chanae My Password
|- My Personalizations
I My System Profile
|- My Dictionary

pone o - = 0% -

You will be asked to verify that you are ready to Submit.
o If“Yes” click “Submit”
e If “No” click “Cancel” to go back to the document

An email will now be sent to the reviewing manager to alert them that the employee evaluation
has been submitted for approval (see below).
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From: Employee Self Service Email

iSent: Wednesday, October 24, 2012 11:21 AM
To:

\Subject: Reviewing Manager Approval Needed.

This automatic notification is to alert vou that the Annual Performance Review performance
evaluation for is readv to be approved. You mav click on this link to go directly to
the application: https:/‘route8 Esvt state ga us'psp/hemtest’ (Please do not respond to this
antomatic notification.)

The reviewing manager will either approve or deny the evaluation. If the document is approved,
it will be routed to the HR Admin for approval. If the document is denied, it will be routed back

to the manager for editing.

Note: If you find that you need to edit the evaluation AFTER you have submitted for approval,
you have two options:

1. Ask the reviewing manager to deny the evaluation. This will allow you to go back in the
evaluation and edit it.

2. Call the HR Admin to have the evaluation reopened.
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